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Cool Reaction! The Reaction of
Baking Soda and Vinegar

Have you ever mixed vinegar and baking soda? It's fun to watch, but did you know that the
reaction between the two is actually a chemical reaction that produces gas and changes
temperature, t0o? The gas it produces is carbon dioxide, CO,, and the temperature
changes. Does the temperature go up or down? We will soon find out!

OBJECTIVES
In this activity, you will

* Produce a reaction between baking soda and vinegar.
» Measure the changing temperature of a reaction,
» Make observations.

MATERIALS

computer with Logger Lite sof tware installed
GolTemp temperature probe

goggles

cup with fill-level marking

plastic spoon

baking soda

vinegar

paper towels or rags to clean up spills

tray

.
PROCEDURE o o
1. .Get goggles and wear them. .

2. Make sure the GolTemp is connected to the computer.

3. Start Logger Lite on your computer.
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10. Data collection will last 40 seconds. During this time, you should make observations
about the temperature changes displayed on the screen, and about what is happening in

the cup.

11. Record your observations on the Observations Sheet about the change in temperature
and what happened in the cup during the reaction.

12. When data collection is complete, dispose of your materials as directed by your
teacher.

Observations Sheet

Write observations about the reaction and the change in temperature of the mixture.
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Vernier Lab Safety Instructions Disclaimer

THES IS AN EVALUATION COPY OF THE VERNIER STUDENT LAB.

This copy does not include:
e Safety information
e Essential instructor background information
e Directions for preparing solutions
e [Important tips for successfully doing these labs

The complete Elementary Science with Vernier lab manual includes 43 labs and essential
teacher information. The full lab book is available for purchase at:
http://www.vernier.com/cmat/ewv.html
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Cold as Ice

Ice water can be pretty cold, Is it always the same temperature? Is there anything you
can do to make it even colder?

OBJECTIVES
In this activity, you will

» See how salt affects the temperature of freezing water.
» See how low you can decrease the temperature of liquid water.

MATERIALS

computer with Logger Lite software installed
GolTemp temperature probe

cup

tap water

ice cubes

plastic spoon

2 spoonfuls of table salt

paper towels or rags to cleanup spills

tray (if available)

KEY QUESTION

How low can you drop the temperature of water while still keeping it liquid?

PREDICTION
I predict I can drop the temperature of water to °C by adding

to the water.
PROCEDURE

1. Make sure the GolTemp is connected to the computer.

2. Start Logger Lite on your computer,
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b. Repeat Steps 5-6 to collect ice water data.
c. When you write down the temperature, write it under the heading: Ice water
temperature, and when you label your data, type: Ice water.
8. Collect data with salt and ice in the water by doing the following:
a. Add 2 spoonfuls of salt to the ice water,

b. Repeat Steps 5-6 to collect data for the ice water with salt. When you write down
the temperature, write it under the heading: Ice water with salt temperature, and
when you label your data, type: Ice water with salt.

ANALYZE YOUR DATA
1. What happened to the temperature of the water as you added ice?

2. What do you think would happen if you continued o add ice cubes to the water? Could
you ever drop the temperature below zero degrees Celsius?

3. What surprised you about the addition of salt?

4. What could you do to drop the temperature even more?

Good job!!
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Graphs made using a Motion Detector can be used to study motion. A Motion Detector measures
the distance to the nearest object in front of it by emitting and receiving pulses of ultrasound. A
calculator can use distance and time measurements to calculate velocity. In this experiment, you
will use a LabQuest and a Motion Detector to produce graphs of your own motion.

Graphing Your Motion

OBJECTIVES

In this experiment, you will
» Use a LabQuest and a Motion Detector to measure distance and velocity.

» Use a LabQuest to produce graphs of your motion.
+ Analyze and interpret graphs of your motion.

MATERIALS
LabQuest meter stick
LabQuest App masking tape

Vernier Motion Detector

walk back and forth
in front of
the wall

EETERER L |- T - ¥

PROCEDURE

Part A Position

I. Find an open area at least 4 m long in front of a wall. Use short strips of masking tape on the
floor to mark distances of | m, 2 m, and 3 m from the wall. You will be measuring your
position from the Motion Detector in your hands to the wall,

Motion Detector to DIG 1 of LabQuest and choose New from the File
menu. If you have an older sensor that does not auto-ID, manually set up

2. If your Motion Detector has a switch, set it to Normal. Connect the k
the sensor. @
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3.

On the Meter screen, tap Length, then change the data-collection length to 10 seconds. Select
OK.

Open the hinge on the Motion Detector. When you collect data,
hold the Motion Detector so the round, metal detector is always
pointed directly at the wall. Sometimes you will have to walk
backwards.

Explore data collection for a position vs. time graph.

. Take a starting position one meter in front of the wall.

b. Signal your partner to start data collection.

c. When the fast clicking begins, walk to a distance of two meters and stop.
d

After data collection is complete, a graph of position vs. time will be displayed. Discuss the
results with your partners.

a

Repeat Step 5 walking more quickly this time.

Match a position vs. time graph.

a. Choose Motion Match B New Position Match from the Analyze menu. A target graph will
be displayed for you to match.

Examine the graph and plan what you will do to match it.

Take your starting position in front of the Motion Detector.

Have your partner start data collection.

Move according to your plan.

Examine the graph of the results.

In Processing the Data (Part A), sketch a graph of your results in the space provided.
Important: Your sketch should show both the target line produced by LabQuest and the
graph of your motion. Then, in the space provided, describe what you had to do to match
the first graph.

h. If you would like to try matching the same graph, start data collection again when you are
ready to stalk walking. If you are ready to match another graph, proceed to Step 8.

©me a0 o

Repeat Step 7 so everyone in your group has a chance to match a position vs. time graph.
Note: When you choose Motion Match P New Position Match again, a new target graph will
be displayed.

PROCESSING THE DATA (PART A)

1.

2.

Describe the difference between the two lines on your graph made in Steps 5-6. Explain why
the lines are different.

How would the graph change if you walked toward the Motion Detector rather than away
from it? Test your answer using the Motion Detector.
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3.

4.

What did you have to do to match the graph you were given in Step 7?

Sketch a position vs. time graph for a car that starts slowly, moves down the street, stops at a
stop sign, and then starts slowly again.

Position

Time

Part B Velocity

9.

10.

1.
12.

13.

14.

[5.

16.

Choose Motion Match P Remove Match from the Analyze menu. Change the y-axis to
velocity. To do this, tap the y-axis label and select Velocity.

Make a graph of your motion when you walk away from the detector with constant velocity.
To do this, stand about | m from the wall. Have your lab partner start data collection, then
walk slowly away from the Motion Detector. After data collection is complete, a graph of
velocity vs. time will be displayed. Discuss the results with your partners.

Repeat Step 10 walking more quickly this time.

LabQuest can also generate random target velocity graphs for you to match. Choose Motion
Match P New Velocity Match from the Analyze menu to view a velocity target graph.

Write down how you would walk to produce this target graph. Sketch or print a copy of the
graph.

To test your prediction, choose a starting position and stand at that point. Have your partner
start data collection. When you hear the Motion Detector begin to click rapidly, walk in such
a way that the graph of your motion matches the target graph on the screen. It will be more
difficult to match the velocity graph than it was for the position graph.

If you were not successful and want to match the same target graph again, start data
collection when you are ready to start walking. Repeat this process until your motion closely
matches the graph on the screen. Print or sketch the graph with your best attempt.

Repeat Steps 12-15 so everyone in your group has a chance to match a velocity vs. time
graph. Note: When you choose Motion Match P New Velocity Match again, a new target
graph will be displayed.

Physical Science with Vernier 35-3



LabQuest 35

PROCESSING THE DATA (PART B)

5. Describe the difference between the two lines on the graph made in Step 10-11. Explain why
the lines are different.

6. What is the definition of velocity?

7. What did you have to do to match the graph you were given in Step 12?7 How well does your
graph agree with the graph provided?

Velocity

Tirre

8. Sketch a velocity vs. time graph for a person who walks, stops for a few seconds, and then
starts to run.

Velocity

Tirme
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Oceanographers, marine geologists, and archeologists use echo sounders to investigate objects
below the surfaces of bodies of water. An echo sounder consists of a transducer that sends out
and receives sound waves. A signal is sent out and bounces back from a submerged surface.
Scientists use the speed of sound in water and the time it takes for the signal to bounce back to
calculate the depth of the object. The deeper the object, the longer it takes for the sound to return.
A map of the ocean floor is made by sending
out a series of “pings” in a grid pattern and
recording the depths. Echo sounders use
different frequencies to map different things
on the ocean floor.

Mapping the Ocean Floor

Sonar, which is short for sound navigation
ranging, is the name given to this echo
sounding system. It was invented during
World War I to detect submarines. The
Vernier Motion Detector works in a similar
manner. In this activity, you will use a
Motion Detector to map objects on a
simulated ocean floor.

OBJECTIVES

In this experiment, you will

+ Use a Motion Detector to measure distances.
» Map simulated ocean floors.

MATERIALS
LabQuest 1 m board
LabQuest App masking tape
Motion Detector 2 or more boxes
PRE-LAB QUESTIONS

1. What else can you think of that measures distance by sending out a sound signal?

2. What factors make it difficult to study the ocean floor directly?
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Figure 1

PROCEDURE
Part | Ocean Floor 1

1.

Prepare the Motion Detector for data collection.

a. Get the board that will act as the support for your Motion Detector.

b. Tape or clamp the Motion Detector to one end of the board. Make sure that the round
screen of the Motion Detector is not covered and is pointing downward.

c. Place the board with the Motion Detector flat on your table as shown in Figure 1.

Prepare the ocean floor for data collection.
a. Place the box on the floor underneath the Motion Detector. Note: The Motion Detector
must be at least 40 cm from the top of the box.

b. Line up the Motion Detector so that when it is moved along the table edge it will pass over
the box.

If your Motion Detector has a switch, set it to Normal. Connect the ’x
Motion Detector to DIG 1 of LabQuest and choose New from the File ==

menu. If you have an older sensor that does not auto-1D, manuaily set up @
the sensor.

On the Meter screen, tap Rate. Change the data-collection rate to 4 samples/second and the
data-collection length to 15 seconds.

Collect distance data.

a. Move the board to position the Motion Detector to the left of the box.

b. When everything is ready, start data collection. Then, slowly slide the board across the
tabletop so that the Motion Detector passes over and past the box.

Determine and record the distance to the floor.

a. Identify a flat portion of the graph that represents the floor. Tap and drag your stylus
across the region that represents the floor to select the region.

b. Choose Statistics P> Position from the Analyze menu.

Record the mean (average) distance to the floor in meters.

d. Choose Statistics» Position from the Analyze menu to turn off the statistics.

o
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7. Determine and record the distance to the box.

a. Identify the flat portion of the graph that represents the box.

b. Tap and drag your stylus across the region that represents the box to select the region.
c¢. Choose Statistics? Position from the Analyze menu,
d. Record the mean (average) distance to the box in meters.

8. Sketch and label your graph.

Part li Ocean Floor 2
9. Prepare Ocean Floor 2.

a. Set up two boxes in the shape of steps. The tallest box must be at least 40 cm from the

Motion Detector.

b. Repeat Steps 5-8. Be sure to record all three distances.

Part il Hidden Ocean Floor

10. Your teacher will have a hidden ocean floor for you to measure. Repeat Steps 5-8 for the

concealed object or objects

Graph Sketches

Ocean Floor 1

DATA

Ocean Floor 2

Hidden Ocean Floor

Distance to
floor (m)

Distance to
box (m)

Box height
(m)

Ocean floor 1
single box

Ocean floor 2
box 1

Qcean floor 2
box 2

Hidden ocean floor
box 1

Hidden ocean floor
box 2

Hidden ocean floor
box 3 (if detected)

Earth Science with Vernier
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PROCESSING THE DATA

1. In the space provided in the data table above, find the height of each box. Do this by

subtracting the distance to the box from the distance to the floor.

2. Which was your best result? Why do you think it was better than your other results?

3. How did the shape of your graph compare to the actual object(s) in each case? Explain.

EXTENSIONS

1. Try other hidden ocean-floor arrangements.

2. Research the sonar process and compare it to what you did in this activity.

19-4
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Experiment

TEACHER INFORMATION _ : : 1 9

Mapping the Ocean Floor

1, The student pages with complete instructions for data collection using LabQuest App,
Logger Pro (computers), EasyData or DataMate (calculators), and DataPro (Palm handhelds)
can be found on the CD that accompanies this book. See Appendix A for more information.

2. The boxes shiould be at least 50 cm wide.

3. Best results are obtained when the boxes are located touching each other or at Jeast 50 cm
apart.

4. The tabletops should be smooth and flat.

=5 IB)oards longer than one meter ¢an be used. They should provide rigid support for the Motion
etector. :

6. The hidden arrangement can be located behind a counter or demonsiration table.

SAMPLE RESULTS

20
15
E 10
£ s 1 L \
0.0=—/ \=
0 2 4 5 8 10
Time (@)
A Two-Box Simulared Ocean Floor
ANSWERS TO QUESTIONS

1.~ See the Sample Resuits.
2. The shape of the graph is similar to the shape of the objects.

3. Real ocean-floor mapping is affected by the water, water temperature, ocean currents,
weather, and interfering objects.

ACKNOWLEDGEMENT

We wish to thank Don Volz and Sandy Sapatka for their help in developing and testing this
experiment. .
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Mapping the Ocean Floor Name:
Instructions and data sheet

Background:

The surface of the oceans covers an area of more than 12 million square km! Did you ever wonder what was below the
surface of all that water? Many early explorers did, and they used several methods to try to determine the shape of the
ocean floor. At one time, sailors tied weights to the end of ropes and lowered them to the ocean floor, marked the
distance when the rope hit bottom, and then measured that distance. You canimagine what a slow process this was!

In the early 1900s, sonar was invented by a French scientist. He used this technology to get sound wave readings of the
ocean floor. This was a great discovery because it allowed scientists to get faster and more accurate readings. A device
called an “echo sounder” is simply aimed downward, at which point it gives off a sound signal. The sound signal travels
to the ocean floor and bounces, or “echoes”, off the surface. The device picks up the echo and then computes the
ocean depth at that point. To do this calculation yourself, all you need to know is the speed of sound in water (1,500
m/s), and the time it took for the sound signal to echo.

During this activity, you will use this method to construct a map for two different regions of the ocean floor.

Procedures:
Atlantic Profile:

1. Compute the Tota/ Distance Traveled by the Sound by multiplying the Time for the Signal to Return by the
Speed of Sound (1,500 m/s).

2. Record this distance on the Data Table on the back of this sheet.

3. Divide your Total Distance Traveled by 2 to get your Ocean Depth in meters.

4. Record this depth on the Data Table,

5. Plot the Distance from Beach (x-axis) and the Ocean Depth {y-axis) in meters using the Atlantic Profile graph
on the “Mapping the Ocean Floor Lab” handout. Sea level (Depth = 0 meters) is the line already shown on
the graph.

6. Once the points are plotted, connect the points and shade in the profile of the ocean floor.

7. Label the following ocean floor features on your graph. Use page 48 and 49 as a reference.

I Continental Shelf, Continental Slope, Continental Rise, Island, Mid-ocean ridge, Abyssal Plain I

Pacific Profile:

1. Using the Pacific Profile data on the “Mapping the Ocean Floor Lab” Lab Sheet Plot the Distance from Beach
on the x-axis and the Ocean Depth on the y-axis. For this set of data, the depth has already been calculated
for you.

2. Once the points are plotted, connect the points and shade in the profile of the ocean floor.

3. Label the following ocean floor features on your graph. Use page 48 and 49 as a reference.

Continental Sfope (directly next to shore), Seamount, Trench {the deep one) I

4. This map shows both the Philippine Plate and Pacific Plate. Within the oceanic crust beneath the ocean
floor, sketch what you think the subduction zone would look like. {Show one plate going under the other.)

5. Inthis activity you created two different ocean floor profiles. One major difference between the two
profiles is the scale of the distance from the shore. Even though both of your profile pictures cover the
width of your paper, they do NOT represent the same distance. You need to get a sense of how each of
the two profiles compare to each other. Determine how much of your Atlantic Profile would be
“covered” by the Pacific Profile. To do this, draw a bracket [bracket] at the bottom of your Atlantic
profile representing the width of your Pacific Profile.

* When finished graphing both profiles, answer all discussion questions on the back of your *
graph sheet using complete sentences.



Data for Atlantic Profile

Data for Pacific Profile

Distance from Beach Time for Signal Total Distance Ocean Depth (meters) Distance from Ocean Depth
{km) to Retum Traveled (meters) {Total Distance + 2) Beach {km) {meters)
(seconds) {Time x 1500 m/s)

50 0.4 0 400 above level
100 0.5 8 1300
150 0.6 16 1000
200 0.7 24 30
250 1.1 32 1000
300 1.4 40 3000
350 2.1 48 4000
400 3.2 56 4500
450 3.7 64 3000
500 4.3 72 2800
550 4.9 80 3000
600 54 88 2800
650 5.4 96 3700
700 5.7 104 3000
750 5.7 112 3200
800 5.6 120 2500
850 57 128 3100
900 5.7 136 4200
950 5.7 144 7100
1000 5.7 l 152 8200
1050 5.4 160 11000

1100 5.4 168 10000
1150 4.3 176 9000
1200 3.2 184 8000
1250 0.7 192 7000
1300 above sea level 200 6000
1350 1.4 208 5100
1400 4.3 216 4500
1450 4.9 224 4200
1500 4.9 232 3840
1550 5.4 240 3800
1600 57

1650 5.7

1700 5.6

1750 5.7

1800 5.4

1850 5.4

1900 4.9

1950 4

2000 3.7

2050 4.6

2100 6

2150 4.3

2200 3.2

2250 4.3

2300 5.4

2350 6

2400 6




Name: Period: Date:

Mapping the Ocean Floor Lab
Atlantic Profile

Pacific Profile




Discussion Questions:
Answer in complete sentences.
Atlantic Profile
1. What two pieces of information are needed to determine ocean depth?

2. Describe how a seamount could become an island. ALSO, describe how an island could become a seamount.

3. Theisland on your graph for the Atlantic Profile is part of a chain of islands located near 26°W and 38°N
latitude. Use a globe or world map to locate and identify this island chain.

4. For the first data table, once you have found the total distance traveled by the sound wave, why is it
necessary to divide it by 2? (*HINT: Think about where the sound signal has to travel.)

Pacific Profile
5. This profile shows the seafloor at the Marianas Trench, the deepest known point in any of the world’s
oceans. Describe what’s happening in this area to create this trench. Please write the name of the trench on
your profile.

6. Explain how the seamount (between 72km and 128 km from the shore) may have formed near this trench.

Comparing the two:
7. How do the two profiles differ from one another? Be descriptive of each region of ocean floor.

8. In oceanography, the edges of the continents are referred to as “margins”. Depending on what type of plate
activity is occurring, a margin may be considered an active margin or a passive margin. Based on your
knowledge of plate tectonics, which of the two profiles would you consider to be “active”, and which would
be “passive”. Explain your reasoning in detail, referring to each profile. Then, label each profile as either
“passive” or “active” on each graph.
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Reflectivity of Light 23

Light 1s reflected differently from various surfaces and colors. An understanding of these
differences is useful in choosing colors and materials for clothing, in choosing colors for cars, and
in city planning. Astronomers use reflectivity differences to help determine characteristics of
planets. In this experiment, you will be measuring the percent reflectivity (albedo) of various
colors. You will measure reflection values from paper of various colors using a Light Sensor and
then compare these values to the reflection value of aluminum foil. The aluminum foil will
arbitrarily be assigned a reflectivity of 100 percent. You will then calculate percent reflectivity
using the relationship

value for paper
value for aluminum

% Reflectivity = « 100

OBJECTIVES

In this experiment, you will

» Use a LabQuest and a Light Sensor to measure reflected light.
» Calculate percent reflectivity of various colors.
» Make conclusions using the results of the experiment.

MATERIALS
LabQuest white paper
LabQuest App black paper
Light Sensor 2 other pieces of colored paper
ring stand and utility clamp aluminum foil

Figure 1
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PROCEDURE

1.

If your Light Sensor has a switch, set it to 600 lux. Connect the sensor to LabQuest and
choose New from the File menu. If you have an older sensor that does not auto-ID, manually
set up the sensor.

Set up the mode.

a. On the Meter screen, tap Mode. Change the mode to Selected Events.
b. Select Average over 10 seconds and select OK.

Start data collection.

Use a utility clamp and ring stand to fasten the Light Sensor 5 cm from and perpendicular to a
piece of colored paper as shown in Figure 1. The classroom lights should be on.

When the light reading displayed on the screen is stable, tap Keep. Note: LabQuest will be
taking data for the next 10 seconds.

Obtain a second piece of colored paper. Repeat Steps 4-5. Continue with this method to
collect and record readings for aluminum, black, white, and two other colors.

Stop data collection and tap Table to view the data. Record the reflection values in your data
table.

DATA
Color Aluminum Black White
Reflection
Value

PROCESSING THE DATA

1.

Calculate the percent reflectivity (albedo) of each color using the formula given in the
introduction. Show your work and record the results in the table below.

Color Aluminum Black White
Percent
Reflectivity 100%
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2. Which color, other than aluminum, has the highest reflectivity?

3. Which color has the lowest reflectivity?

4. What materials might give a planet a high reflectivity or albedo? Explain.

5. Does the planet Earth have high reflectivity? Why?

EXTENSION

1. Design an experiment to determine if there is a relationship between reflected light and heat
absorbed by various colors or materials.
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Does the position of your body affect your heart rate? In this experiment, you will use a Heart
Rate Montitor to measure your heart rate while sitting, lying, and standing. You will then use your
results to answer the question.

Heart Rate and Body Position

OBJECTIVES

In this experiment, you will

+ Use a Hand-Grip Heart Rate Monitor or Exercise Heart Rate Monitor to measure your
heart rate while sitting, lying, and standing.

» Analyze the results of your experiment.

» Compare your results with those of other students.

» Answer the question posed in the introduction.

MATERIALS
computer Vernier Hand-Grip Heart Rate Monitor or
Vernier computer interface Vernier Exercise Heart Rate Monitor

saline solution in dropper bottle
(for use with Exercise HR Monitor)

PROCEDURE

1. Plug the receiver module of the Heart Rate Monitor into the Vernier computer interface.

2. Start the Vernier data-collection program and open the file “25 Heart Rate Position” from the
Middle School Science with Vernier folder.

Using a Hand-Grip Heart Rate Monitor
Use the following instructions if you are using a Hand-Grip Heart Rate Monitor.

3. Stand facing your table or lab bench. Grasp the handles of the Hand-Grip Heart Rate Monitor
your hands. The fingertips of each hand should be placed on the reference areas of the
handles. The left hand grip and the receiver are both marked with an alignment arrow. When
collecting data, be sure that the arrow labels on each of these devices are in alignment (see
Figure 1). The reception range of the plug-in receiver is 80—100 cm, or about 3 feet.

Figure 1
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4. Click to determine that the sensor is functioning correctly. There will be a 15 second
delay while data are collected before the first point is plotted on the upper graph. Thereafter,
a point will be plotted every 5 seconds. The readings should be consistent and within the
normal range of the individual, usually between 55 and 90 beats per minute.

5. If the readings appear unreasonable, reposition your fingers and check the sensor and receiver
alignment.

6. Once it is apparent that the sensor is functioning correctly, click and continue with
Step 11.

Using an Exercise Heart Rate Monitor

Use the following instructions if you are using an Exercise Heart Rate Monitor.

7. Depending upon your size, select a small or large size elastic strap. Secure one of the plastic
ends of the elastic strap to the transmitter belt. It is important that the strap provide a snug fit
of the transmitter belt.

8. Wet each of the electrodes (the two

textured oval areas on the underside 7N f;‘r
of the transmitter belt) with 3 drops ) V
of saline solution.
9. Secure the transmitter belt against : ﬁhes‘ belt
the skin directly over the base of the /g__,)‘ g -3 *]\J
rib cage. The POLAR logo on the
front of the belt should be centered. jmlﬁ‘
Adjust the elastic strap to ensure a
tight fit. Figure 2

10. Take the receiver module of the Heart Rate Monitor in your right hand and have a seat well
away from the computer monitor. Face away from the computer monitor and your classmates.
Sit quietly. Remember that the receiver must be within 80 cm of the transmitter in the Heart
Rate Monitor belt.

Part | Sitting Heart Rate

11. Once the subject has been seated quietly for about a minute, a partner should click to
begin monitoring heart rate.

Part Il Reclining Heart Rate

12, After 4 minutes of data collection have gone by, the subject should recline on a clean surface
or table and facing away from the computer monitor and all classmates. Note: A partner
should tell the subject when it is time to recline.

Part lll Standing Heart Rate

13.  After 8 minutes of data collection have gone by, the subject should stand facing away from
the computer monitor and all classmates. A partner should again tell the subject when it is
time to stand. Data collection will automatically stop after 12 minutes.
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Part IV Recording Data

14.

15.

16.

17.
18.

Determine the subject’s sitting heart rate.

a. Move the mouse pointer to the 2 minute line.

b. Press the mouse button and hold it down as you drag across the graph to the 4 minute line
to select this part of the graph.

c. Click the Statistics button 2] Record the Mean (average) sitting heart rate (in bpm).

Determine the subject’s reclining heart rate.

a. Move the mouse pointer to the 6 minute line.

b. Press the mouse button and hold it down as you drag across the graph to the 8-minute line
to select this part of the graph.

¢. Click the Statistics button, il Record the Mean (average) reclining heart rate (in bpm).

Determine the subject’s standing heart rate.

a. Move the mouse pointer to the 10 minute line.

b. Press the mouse button and hold it down as you drag across the graph to the 12-minute
line to select this part of the graph.

c. Click the Statistics button, i Record the Mean {average) standing heart rate (in bpm).
d. Close all of the Statistics boxes.

Print copies of the graph as directed by your teacher.

Repeat Steps 317 with other members of the team serving as subjects.
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DATA

Subject's name

Sitting heart rate (beats/min)

Reclining heart rate (beats/min)

Standing heart rate (beats/min)

Difference between sitting and
reclining heart rates (beats/min)

Difference between standing and
sitting heart rates {beats/min)

Difference between standing and
reclining heart rates (beats/min)

PROCESSING THE DATA

1. In the space provided in the data table, subtract to calculate the difference between the sitting
and reclining heart rates for each subject.

2. Subtract to find the difference between the standing and sitting heart rates for each subject.
3. Subtract to find the difference between the standing and reclining heart rates for each subject.

4. Does the position of your body affect your heart rate?

5. Compare your results with those of other students.

6. Try to explain the results of the experiment.

EXTENSION

1. Measure your heart rate while standing on your head. Compare the results with your other
results.
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40

Learning to Use a Voltage Probe

A Voltage Probe can measure the voltage of a battery. This is one way of checking whether
a battery is good. In this activity, you will learn about the Voltage Probe by working with a
battery.

OBJECTIVES
In this activity, you will

+ Learn to use the Voltage Probe.
» Measure the voltage of a battery.
» Match patterns on LabQuest.

MATERIALS

LabQuest
Vernier Differential Voltage Probe
battery

ruler with center groove

PROCEDURE

Part I Learn About the Voltage Probe
1. Make sure the Voltage Probe is connected to LabQuest.

2. Choose New from the File menu.

3. On the Meter screen, tap Length. Change the data-collection length to 20 seconds.
Select OK.

4. Look at the materials you will be using in this activity.

a. Pick up the battery. Do you know which end is the positive end and which is the
negative? Make sure everyone in your group agrees upon which is positive and which
is negative and put the battery in the groove in the ruler.

b. Now, look at the clips of the Voltage Probe. You will be touching the metal tips of
these clips to the ends of the batteries later on.
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5. Zero the Voitage Probe.
a. Clip together the ends of the red and black wires coming from the Voltage Probe.

b. Look at the screen and choose Zero from the Sensors menu to zero the Voltage
Probe. The voltage readings should be at or near O V.

c. Disconnect the clips.

6. Collect data using the Voitage Probe by following the steps below. After you collect
data, you wifl record your observations, so be sure to pay close attention!

a. Look at the screen and start data collection.

b. Touch the two Voltage Probe clips together. Notice if anything happens to the
voltage values.

¢. Now, touch the black clip to the positive end of the battery (the side with the bump)
and the red clip to the other end, and hold them for a few seconds. Are the voltage
values negative?

d. Finally, switch the clips around so the red clip touches the positive end of the
battery and the black clip touches the negative end. Are the voltage values negative
now?

e. Stop data collection if it has not stopped already.
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7. Onthe Observations Sheet below, write down what happened when you were collecting
data.

Observations Sheet

1. When I touched the two clips together, the voltage

2. When I touched the black clip to the positive end of the battery and the
red clip to the negative end of the battery, the voltage

3. When I touched the red clip to the positive end of the battery and the
black clip to the negative end of the battery, the voltage
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Part II Matching Patterns with the Voltage Probe

8.

10.

In this part of the activity, you will [#|% File Graph Analyze
complete writing the steps necessary e
to match the pattern on the graph.
Think about how you would do this and
fill in the blanks below. Note: Your
voltage readings might not match the
pattern, exactly. It is most important
to make the pattern similar to that on
the graph, rather than reach the same
voltages. 2.0

L 0.0 Time (sec)
a. Start with the red clip touching the

Potential (v}

(positive or negative) end and the black clip touching the

(positive or negative) end of the battery.

b. Keep the clips in this position for seconds.

c. Quickly, touch the clips together and hold them there for seconds.
d. Quickly, touch the red clip to the (positive or negative) end and the

black clip to the other end and hold them there for seconds.

e. Quickly, touch the clips together and hold them there for seconds until

data collection ends.

Start data collection and follow the steps you wrote in Step 8.

If your data matches the original pattern, congratulations! If you want to try again,
repeat the steps you wrote in Step 8.

Good jobl!
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Are All Batteries the Same?

Why are there so many kinds and sizes of batteries? Does the size of the battery
determine the voltage of the battery? In this activity, you will set up an electrical circuit
and investigate some of the properties of batteries.

OBJECTIVES
In this activity, you will

» Make observations about the size of different batteries.
» Use a probe to measure the voltage of various batteries.
» Make simple circuits with batteries and bulbs.

MATERIALS

LabQuest

Vernier Differential Voltage Probe

TI Light Probe

1 AAA battery

2 AA batteries

1 C battery

2 D batteries

small light bulb in socket

ruler with groove for holding batteries
2 jumper wires with alligator clips on each end
masking tape

PROCEDURE

Part I Looking at Batteries and Measuring Voltages
1. Your teacher is going to hold up different batteries. The voltage of the AAA battery is
1.5 volts.

2. Predict the voltages of the other batteries and record your predictions in the
Predicted voltage column of the Part I Data Table on the next page. The first one has
been filled in for you.
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Part I Data Table
Predicted Voltage printed
Battery type voltage Measured voltage on battery
AAA battery 15v v v
AA battery v v v
C battery v v v
D battery v v v

3. Make sure the Voltage Probe is connected to LabQuest.
4. Choose New from the File menu.

5. Zero the Voltage Probe:

a. Clip together the ends of the red and black
wires coming from the Voitage Probe.

b. Look at the screen and choose Zero from
the Sensors menu to zero the Voltage Probe.
The voltage reading on the screen should be
at or near O V.

6. Measure the voltage of each battery:

a. Place the red clip of the Voltage Probe on the positive (+) end of the battery and the
black clip on the negative (-) end of the battery.

b. Look at the voltage displayed on the screen.

¢. Record the value in the Part I Data Table above in the Measured voltage column.

7. Repeat Step 6 for each of the batteries. Do not forget to record your values in the
Part I Data Table.

8. Now, read the voltage listed on the side of each battery (you may need a magnifying
glass for some batteries). Record the voltage values in the Part I Data Table under
Voltage printed on battery.
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Part II Using Batteries to Light up a Light Bulb

9.

10.

11.

12.

Do the following to get the sensor ready for this part of the activity.

a. Disconnect the Voltage Probe and connect the Light Probe.

b. Choose New from the File menu.

c. Lay the Light Probe on the table and tape it down.

d. Put a piece of tape on the table, with one edge right under the tip of the probe.

Set up the circuit pictured here using the
AAA battery, wires, and the light bulb. Place
the tip of the light bulb on the edge of the
tape so it is pointing straight at the Light
Probe. Someone in your group should hold
the socket of the bulb in place during data
collection. Careful: Do not put your finger
between the Light Probe and the bulb when
you are collecting datal

Now follow these steps to find out how bright the light bulb is:
a. Touch one of the jumper wire cables to the positive end of the battery.
b. Touch the other jumper wire cable to the negative end of the battery.

c. Look at the Light Level values on the screen. When the number stays the same for a
few seconds, record the value in the Part IT Data Table.

Part II Data Table
:aype of Light Level Type of battery Light Level
tery L
R in circuit
in circuit
AAA battery C battery
AA battery D battery

Repeat Step 11 using a different battery in the circuit each time. Make sure the light
bulb is in the right place and don't forget to record the Light Level in the Part II Data
Tablel
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ANALYZE YOUR DATA

1. Look at the values for the voltages for the different batteries in the Part I Data
Table. How do the voltages you measured compare to your predictions? Why did you
make your prediction as you did?

2. What did you notice about the brightness of the bulbs when using the different
batteries to light them in Part II? Did the size of the bulb seem to make a difference
in how bright the bulb was? Look at your data to help you answer these questions.

Good jobl!
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Stacked Batteries

Did you ever wonder why it takes two batteries stacked together to run a flashlight or why
your video game player takes four batteries? Why do they need to be put into these
devices a certain way? This activity will allow you to explore how all this works by
measuring the voltages across different numbers of batteries stacked together.

OBJECTIVES
In this activity, you will

» Measure the voltages of batteries as they are stacked together.
« Compare the voltages of different types of stacked batteries.
o Draw conclusions about batteries in electronic devices.

MATERIALS

LabQuest

Vernier Differential Voltage Probe

4 D batteries

4 AA batteries

ruler with groove for holding batteries

KEY QUESTION

What do you think will happen to the voitage as you add more D batteries together and
measure the voltages from the end of the first battery to the opposite end of the last
battery?

HYPOTHESIS

The voltage will by volts every time an additional
D battery is added to the stack.

Elementary Science with Vernier 42 - 1



LabQuest 42

PROCEDURE

Part I Measure the Voltage of Stacked D Batteries
1. Make sure the Voltage Probe is connected to LabQuest.

2. Choose New from the File menu.

3. Set up the data-collection mode.
a. On the Meter screen, tap Mode. Change the mode to Events with Entry.
b. Enter the Name (Batteries) and leave the Units field blank. Select OK.

4. Zero the sensor and begin data collection by doing the following:
a. Clip together the ends of the red and black wires coming from the Voltage Probe.
b. Look at the screen and choose Zero from the Sensors menu to zero the Voltage
Probe. The voltage reading on the screen should be at or near O volts.
5. Collect data by following these steps:
a. Start data collection.
b. Tap Keep and enter O for O batteries. Select OK.
c. Put the ruler on the table and put one D battery in the groove of the ruler.

d. Now press the red clip to the positive end of the battery, and press the black clip to
the negative end of the battery.

e. When the voltage reading stays the same for a few seconds, tap Keep.
f. Enter 1 for 1 battery, then select OK.
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6. Collect data for 2 stacked batteries.

a.

7. Collect data for the 3™ and 4™ batteries by doing the following:

a.

c. When the readings are the same for a few seconds, tap Keep.
d.

e.

8. When you have collected data for 4 batteries, stop data collection.

Place a second battery on the ruler
with the negative end of this battery
touching the positive end of the first
battery.

. Hold the red clip against the positive

end of the first battery and the black
clip against the negative end of the
second battery.

When the readings are the same for a
few seconds, tap Keep.

Enter 2 for 2 stacked batteries and
then select OK.

Place another battery on the ruler with the negative end of this battery touching

the positive end of the battery before it.

Enter 3 for 3 stacked batteries and then select QK.

Repeat this step with 4 batteries in the stack.

. Hold the red clip against the positive end of the first battery in the row and the
black clip against the negative end of the last battery in the row.

9. Tap the Table tab. Look at the voitage values in the Potential column and record the
voltages in the Part I Data Table, below.

Part I Data Table

Number of D batteries

Potential

1 battery

2 batteries

3 batteries

4 batteries

Elementary Science with Vernier
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Part II How Do AA Batteries Stack Up?

Key Question

What do you think will happen to the voltage as you add AA batteries together and
measure the voltage? Will the voltage of AA batteries change the same amount as the
voltage changed when you stacked D batteries? Why or why not?

Hypothesis

The voltage will by volts every time another AA battery is
added to the stack.

Prediction

Tap the 6raph tab. Choose Draw Prediction from the Analyze menu. Draw what you think
will happen to the voltages as you add more AA batteries. Select OK.

10. Tap the File Cabinet icon to store your data and repeat Steps 5~9, using the AA
batteries in place of the D batteries. This time, write down your data in the table
below.

Part II Data Table
Number of AA batteries Potential

1 battery

2 batteries

3 batteries

S| < | < | <

4 batteries

ANALYZE YOUR DATA

1. How did your prediction from Part IT match your data?
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2. What do you think the voltage would be if you added together 10 batteries? Why?

3. Compare your data from Parts I and II of this activity. Describe how they are the
same and different. Do the similarities and dif ferences surprise you?

Good joblt
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An Inclined Plane

An inclined plane is a slanted surface used to raise objects. The sloping floor of a theater, a road
over a mountain, and a ramp into a building are examples of inclined planes. In this experiment,
you will use a Force Sensor to measure the force needed to lift an object and the force needed to
pull the same object up an inclined plane. You will then calculate and compare work done in
raising the object to the same height by lifting it and pulling it up an inclined plane.

OBJECTIVES

In this experiment, you will
¢ Use a LabQuest and a Force Sensor to measure force.
+ Compare forces.

« Calculate work and efficiency.
» Make conclusions using the results of the experiment.

MATERIALS

LabQuest wooden block with a hook

LabQuest App books

Vernier Force Sensor metric ruler

smooth board (at least 0.5 m long) paper clip

VS
Figure 1: Using the Dual-Range Force Sensor

PROCEDURE

Using an Inclined Plane
1. Set up a stack of books as shown in Figures 1.
2. Get a board and set up an inclined plane as shown in Figures 1. Measure the length of the

board (in meters) and record this value in the data table. Measure and record the height of the
inclined plane (in meters).

3. Get a wooden block with a hook on one end. Partly straighten a paper clip—leaving a hook at
each end. Use the paper clip to attach the wooden block to your Force Sensor.

4. Set the range switch on the Force Sensor to 10 N. Connect the Force Sensor to LabQuest and
choose New from the File menu. If you have an older sensor that does not auto-ID, manually

set up the sensor.
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5. Slowly pull the wooden block up the inclined plane. The Force Sensor should be held parallel
to, and about 2 cm above, the surface of the inclined plane, as shown in Figure 1. Once the
wooden block is moving at a steady rate, start data collection. Continue pulling the wooden
block until data collection is complete (5.0 seconds).

6. Determine the mean (average) force (in N).
a. After data collection is complete, choose Statistics from the Analyze menu.
b. Record the mean {average) force (in N).

Without an Inclined Plane

7. Now determine the force needed to lift the wooden block.

a. Repeat Step 5 as you slowly lift the block the same height as the inclined plane.
b. Repeat Step 6 and record the value of the force (in N) needed to lift the wooden block.

DATA TABLE
Length of inclined plane
Height of inclined plane
Force (average) to pull the block up the inclined plane

Z Z 3 8

Force (average) to lift the block

PROCESSING THE DATA

1. Does it take more or less force to move the block using the inclined plane? Explain.

2. A formula for calculating work is
W=FXd

where W = work (in N-m), F = force (in N), and d = distance (in m). Use this formula to
calculate work done using the inclined plane. Here, F = the average force needed to pull the
block up the inclined plane and ¢ = the length of the inclined plane.
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3. Calculate work done in lifting the block. Here, F = the average force needed to lift the block
and d = the height of the inclined plane.

4. Does it take more or less work to move the block using the inclined plane?

5. A formula for calculating the efficiency of a machine is

k output
work outpu . 100

efficiency = ork input

Use this formula to calculate the efficiency of the inclined plane. Here, work output = the
work done lifting the block, and work input = the work done pulling the block up the inclined
plane.

6. What causes the difference between the work needed to pull the block up the inclined plane
and the work to lift it to the same height? Discuss ways to decrease this difference.

EXTENSIONS

1. Study how changing the inclined plane slope changes force.
2. Design an experiment to study your answer to Question 6.

3. Determine the mechanical advantage of the inclined plane.
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Experiment
TEACHER INFORMATION 22
An Inclined Plane

1. The student pages with complete instructions for data collection using LabQuest App,
Logger Pro (computers), EasyData or DataMate (calculators), and DataPro (Palm handhelds)
can be found on the CD that accompanies this book. See Appendix A for more information.

2. 'We suggest that you include one of the extension ideas in the required part of this
experiment.

3. The smooth-surface boards used for the inclined plane should be at least 0.5 m long. We use
boards that are 1.2 x 0.25 m.

4. A Scmx 10 cmX 15 cm piece of wood works well. Insert a hook in the center of one end.
Other flat-surface objects can be substituted.

5. The Dual-Range Force Sensor has a low range, —10 to 10 N, and a high range, =50 to +50 N.
Students will use the low range for this experiment.

6. For even better results, you can have students zero the Force Sensor. They should position
their Force Sensor horizontally on the inclined plane, as shown in Figure I of the student
procedure.

7. Nlustrate proper technique for pulling an object up an inclined plane with the force sensor
before the experiment. Remind your students not to pull the object too fast.

8. Your students should get better results using the Force Sensor and average force values than
with spring scales.

SAMPLE RESULTS

Length of inclined plane 1.20m

Height of inclined plane 0.24 m

Force (average) to pull object 1.58 N

Force (average) to lifi object 490N
ANSWERS TO QUESTIONS

1. It takes less force to move the object using the inclined plane.
W=Fxd=158NxXx1.20m= 190 N-m
W=Fxd=490Nx024m=1.18 Nom

el

It takes more work to move the object using the inclined plane.

Ln

Efticiency = 1.18 Nom/1.90 Nem ~ 62.1%

6. Friction causes the work to move the object with the inclined plane to be greater than the

work needed to lft it the same veriical distance.
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Bubbles in Your Bread

Baking bread is something many people all over the world do every day. Have you ever
baked bread using yeast? Did you know that yeast are living organisms? In a water
environment, yeast use sugar and oxygen to produce a gas called carbon dioxide, CO,. The
carbon dioxide makes the dough rise and creates the bubbles or air pockets that you can
see in the bread that you eat.

OBJECTIVES
In this activity you will

¢ Use a Pressure Sensor to measure the pressure caused by the production of COs.
» Make observations about how temperature affects rising dough.

MATERTALS

computer with Logger Lite software installed
&ollink interface

Vernier Gas Pressure Sensor

plastic tubing and stopper assembly
targe bowl

warm water (approximately 30-35°C)
cold water (approximately 5-10°C)
bread dough

plastic bottte

paper towels or rags to clean up spills
tray (if available)

KEY QUESTION

Does temperature make a difference in the amount of time it takes for bread to rise?

HYPOTHESIS

I think that the (warm or cold) bread dough will rise faster because
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3. Open the file for this activity by doing the following:
a. Click the Open button, &
b. Open the file called "Elementary Science *
<. Open the file called *19 Bubbles in Bread.”

4. To prepare the dough for datq collection, follow these steps:
a. Get a ball of dough from your teacher.

b. Put the dough in the bottle, Rolling the dough into a snake shape may help you get it
in the bottle,

Elementary Science with Vernier
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Bubbles in Your Bread

Follow these steps to get ready to collect data:

a. Twist the stopper into the mouth of the bottle so it fits tightly. Important: The
stopper must be twisted in tightly or it may pop out.

5. Put the bottle in the bowl.

>. Have one student hold the bottle down in the bowl, or use masking tape to tape the
bottle down.

1. Carefully pour the cold water into the bowl.
Zlick [»careet] to start data collection,

Jata collection will last 10 minutes, During this time, watch the data and the dough to
ibserve the changes taking place. Record your observations about the pressure and
vhat happened in the bottle during the reaction in the Part T Observations Sheet,

Part I Observations Sheet

Vhen data collection is over, click the
‘tore button, @, to save your data.

Ipen the valve on the stopper and watch what
appens to the pressure. Record what you see on
e Part I Observations Sheet.

Valve Closed

Valve Open

wmtary Science with Vernier 19 - 3



Computer 19

Part II Pressure Change in Warm Water

Prediction
Click the Predict button, |7, and draw a line that shows your prediction for how the
pressure will change as the dough is warmed up.
10. Do the following to get the materials ready for data collection.
a. Empty the cold water as directed by your teacher,

b. Close the valve on the stopper by turning it sideways to the valve, making a plus sign
(see the “Valve Closed" drawing above).

¢. Put the bottle back in the bow).

d. Carefully pour warm water into the bowi.
11, Click [vcorect] to start data collection.

12. Record your observations about the pressure changes and what happens in the bottle
on the Part II Observations Sheet below:

Part IT Observations Sheet

13. Open the valve on the stopper and watch what happens to the
dough. Record what you see on the Part II Observations Sheet.

14, Dispose of your materials as directed by your teacher.

Valve Closed

Valve Open

19 - 4 Elementary Science with Vernier
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ANALYZE YOUR DATA

1. Click the Examine button, 17, to find the pressure at each minute of the experiment.
Record each value in its place in the Data Table.

Data Table
Cold water Warn water
Beginning pressure kPa kPa
Pressure at 1 minute kPa kPe
Pressure at 2 minutes kPa kPa
Pressure at 3 minytes kPa kPa
Pressure at 4 minutes kPa kPa
Pressure at 5 minutes kPa kPa
Pressure at 6 minutes kPa kPa
Pressure at 7 minutes kPa kPa
Pressure at 8 minutes kPa kPa
Pressure at 9 minutes kPa kPa
Pressure at 10 minutes kPa kPa

2. Look at each of the columns in the Data Table. Do you see a pattern in the values for
the warm-water dough? Is there a pattern in the values on the cold-water dough
column?

3. What do you think would happen to the warm-water dough if you allowed the
experiment to run much longer? How about the cold-water dough?
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4. What effect does temperature have on the reaction? Do you think it would be easier
to bake bread on a hot day or a cold day? Why do you think so?

Good jobl!
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Teacher

TEACHER INFORMATION 1 9
Bubbles in Your Bread

BACKGROUND INFORMATION

In this activity, students will observe the pressure caused by gases that are the result of
the digestive processes of yeast working in the dough. Yeast are single-cell fungi, and we
tend 1o think of their work in bread as biological, but it is also a chemical process, These
little organisms are digesting the sugar in the dough and creating carbon dioxide gas,
which makes the little bubbles in bread. Creating a gas is one indication that a chemical
reaction has taken place. In addition to gas, alcohol is produced, giving bread dough its
characteristic smell.

As the bread dough rises, the gases created by the yeast's digestion increase the
pressure. If the temperature is too cold, however, the yeast are not as active and will not
create the gas needed for the dough 1o rise.

TIME FRAME FOR ACTIVITY

This activity can be completed in about 50 minutes after an initial 10-15 minutes for
making the dough.

CURRICULAR CONNECTIONS

Social Studies - Breads from different cultures, basic needs of humans.

Math - Comparisons, graph analysis, volume measurements,

HELPFUL HINTS

1. The student pages with complete instructions for data-collection using Logger Lite or
LabQuest App can be found on the CD that accompanies this book. See Appendix A for
more information.

2. Data can be collected using a Pressure Sensor connected to Gollink on a computer or a
Pressure Sensor connected directly to LabQuest, LabQuest does not support the use
of Gol products.

3. This should probably not be the first Pressure Sensor activity your students do. Begin
with Activity 16, Learning to Use the Pressure Sensor.

4. As aprecurser to this activity, you may want to have kids examine a piece of bread to
find the little bubbles that are the result of the yeast in the recipe.
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9. You should attach the plastic tubing to the stopper prior to giving them to the
students.

6. You will need to provide students with warm and cold water. The warm water should be
about 30~35°C. You can usually obtain water of this temperature from the tap. The
cold water should be about 5-10°C. If your tap water is not this cold, add a little ice.

7. Prepare the dough in front of the students or ahead of time and store it in the
refrigerator until it is needed. Allow time for the dough to return to room temperature
before you give it fo your students. A recipe can be found on page 10-5T.

Another option for the dough is to buy it pre-made, such as the self-rising Rhodes
dinner rolls. Take the dough out of the freezer about 2 hours before starting the
activity. If they are out for a shorter period of time, they might not show much change
because they are still cold. If they are out for too long, they may have finished rising
before you give them to the students. When you take the rolls out, place them
individually on a flat surface so they don't all stick together. Give each student group

3 rolls.

8. Relling the dough into small “shakes” makes it easier to put in the bottles.

9. Inorder fo compare data between the groups, try to give . n group the same amount
of dough. '

10. If you have sufficient materials, you can do both parts of this activity at once.

SAMPLE RESULTS

The amount of dough in your bottle and the temperature of your water will greatly affect
the change in pressure during data collection. It is possible that during the cold dough run,
the pressure will decrease and that during the warm dough run, the pressure will not
increase as much as is does in the sample data below.

] Bubbles in Your Bread
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Pressure change caused by the rising of dough in a
bottle in warm and cold water baths
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Bubbles in Your Bread

Data Table
Cold water Warm water
Beginning pressure 100.0 kPa 101.6 kPa
Pressure at 1 min 99.4 kPa 105.3 kPa
Pressure at 2 min 99.7 kPa 107.3 kPa
Pressure at 3 min 100.1 kPa 109.1 kPa
Pressure at 4 min 100.6 kPa 1112 kPa
Pressure ot 5 min 101.0 kPa 113.2 kPa
Pressure at 6 min 101.4 kPa 1165 kPa
Pressure at 7 min 102.0 kPa 117.3 kPa
Pressure at 8 min 102.2 kPa 119.3 kPa
Pressure at 9 min 102.6 kPa 121.2 kPa
Pressure at 10 min 102.9 kPa 123.3 kPa

ANSWERS TO THE ANALYZE YOUR DATA SECTION

I. Answers are based on each individual graph. Values from the sample data are displayed
in the table above.

2. Answers are based on student graphs, but there should be a pattern that is evident in
the numbers as well as the graph. For example, the cold water dough drops in pressure,
then increases by about 0.4 kPa each minute. The warm water dough increased almost
4 kPa at the beginning, and it continued to increase about 2 kPa each minute after that,

3. If the experiment were allowed to continue, the pressure in the warm dough bottle
would pop the stopper out of the bottle, and the pressure would immediately drop. The
cold water dough would continue to rise very slowly, but as the water warmed, the
pressure in the bottle would rise more like the warm dough.

4. Yeast are not as active in cold temperatures. Therefore, if a cold day means a cold
kitchen, you might not have bread in time for dinner!
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Activity 18

ASSESSMENT

1. Have students write a statement about the effect of temperature on the reaction of
the bread dough and relate it explicitly to the data on their graph.

2. Provide students with a description of an experiment and a graph of pressure vs. time
that is different than the warm water/cold water dough comparison. Have them write a
description of the data shown on the graph.

EXTENSIONS

1. Determine other factors the might affect the way bread rises. Design an experiment
to explore those ideas.

2. Use a yeast-sugar mixture alone (instead of dough) and perform the same experiment,

3. Discuss what happens when you open the valve after you take data. Why does the
dough suddenly expand? (When the valve is opened, the compressed air escapes. This
allows the gas in the dough to expand into the space left by the escaping air.)

4. Research types of bread from different cultures.
5. Find a bread recipe that does not use yeast and use it to perform this activity.

6. If local regulations allow, make extra bread for the entire class to eat.
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Bubbles in Your Bread

Simple Yeast Bread Recipe

450 ml. (2 cups) warm water (water too hot to keep your finger in is too hot)
10 g (2 teaspoons) sugar

7 9 (1 package) fast acting active dry yeast

900 g (3% cups) all purpose flour

14 g (1 tablespoon) salt

Add the sugar and yeast to about 100 g (4 cup) of warm water and dissolve. After a
few minutes, the mixture should have smalt bubbles forming around the edge. This
means the yeast is active.

Meanwhile, put the flour and salt in a large mixing bowl. Mix well and then add about
100 g (7 cup) of warm water. Stir, then add the yeast mixture and blend to make soft
dough. Add as much water and flour as needed to make dough that is not sticky. This
makes it easier for the "bread snakes” to fit through the mouth of the bottle without
sticking.

At this point the dough is ready for the experiment. This makes enough dough for
about six groups. Keep the dough cold before giving it to the students or it may begin
1o rise.

If you make a batch of dough for eating, at this point you would allow the dough to rise
for about 20 minutes, and then bake it in small loaves or rolls on a cookie sheet at
200°C (400°F) for 30 to 45 minutes, depending on the size you choose to make.
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LabQuest

30

Gas Pressure and Volume

In this simple experiment, you will use a Gas Pressure Sensor and a gas syringe to study the
relationship between gas pressure and volume. Temperature and amount of gas will be kept
constant. The results will be expressed in words, in a table, with a graph, and with a mathematical
equation. These are four methods commonly used by scientists to communicate information.

This experiment is similar to one first done by Robert Boyle in 1662—without the use of a
calculator, of course. The relationship you will discover is known as Boyle’s law.

OBJECTIVES

In this experiment, you will
» Use a LabQuest, a Gas Pressure Sensor, and a gas syringe to measure the pressure of an air
sample at several different volumes.
« Make a table of the results.
« Make a graph of the data.
+ Predict the pressure at other volumes.

o Describe the relationship between gas pressure and volume with words and with a
mathematical equation.

MATERIALS
LabQuest Vernier Gas Pressure Sensor
LabQuest App 20 mL gas syringe

i ™,
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Figure 1
PROCEDURE

1. Prepare the Pressure Sensor and an air sample for data collection.

a. Connect the Pressure Sensor to LabQuest and choose New from the File menu. If you have
an older sensor that does not auto-ID, manually set up the sensor.

b. A 20 mL syringe is already connected to the sensor and set at the 10 mL mark for you.
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LabQuest 30

2. Set up the mode.

a. On the Meter screen, tap Mode. Change the mode to Events with Entry.
b. Enter the Name (Volume) and Units (inL). Select OK.

3. You are now ready to collect pressure and volume data. It is easiest if one person takes care
of the gas syringe and another operates LabQuest.

a. Start data collection.

b. Move the piston so the front edge of the inside black ring is positioned at the 5.0 mL line
on the syringe (see Figure 2). Hold the piston firmly in this position until the pressure value
displayed on the screen stabilizes.

¢. Tap Keep and enter 5, the gas volume (in mL). Select OK to store this pressure-volume
data pair.

Figure 2

d. To collect another data pair, move the syringe to 7.5 mL. When the pressure reading
stabilizes, tap Keep and enter 7.5 as the volume. Select OK.

e. Continue with this procedure using volumes of 10.0, 12.5, 15.0, 17.5, and 20.0 mL.
f Stop data collection.

4. To examine the data pairs on the displayed graph, tap any data point. As you tap each data
point, the pressure and volume values are displayed to the right of the graph. Record the
pressure (round to the nearest 0.1 kPa) and volume data values in your data table.

5. (optional) Print a graph of pressure vs. volume.

DATA

Volume 5.0 7.5 10.0 12.5 15.0 17.5 20.0
(mL)

Pressure -
(kPa)
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Gas Pressure and Volume

PROCESSING THE DATA

1. See the data table and note the pressure when the volume is 10.0 mL, and when the volume is
5.0 mL. What happened to pressure when the volume was halved?

2. See the data table and note the pressure when the volume is 20.0 mL. Compare this pressure
to the pressure when the volume is 10.0 mL. What happened to the pressure when the volume
was doubled?

3. From your data and graph, what is the pressure when the volume is 16 mL? 8 mL? How do
these values compare?

4. What would the pressure be at 40.0 mL? At 2.5 mL? Explain how you determined these
values.

5. What is the relationship between gas pressure and volume (Boyle’s law) in words?
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LabQuest 30

6. Do gas pressure and volume vary directly or inversely? Explain.

7. Write an equation to express the relationship between gas pressure and volume. Use the
symbols P, V, and £.

EXTENSIONS

1. Repeat the experiment using a pure, noncorrosive gas, such as oxygen, butane, or carbon
dioxide. Compare the results with your results for air.

2. Plot P versus 1/V and discuss the graph. You can do this using graph paper, Vernier
Logger Pro.
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Experiment

TEACHER INFORMATION 3 0

Gas Pressure and Volume

1. The student pages with complete instructions for data collection using LabQuest App,
Logger Pro (computers), EasyData or DataMate (calculators), and DataPro (Palm handhelds)
can be found on the CD that accompanies this book. See Appendix A for more information.

2. In order to save time, you may prefer to do Step 1 of the student procedure prior to the start of
class.

3. You should never have to perform a new calibration when using the Gas Pressure Sensor.
Simply use the stored calibration in the data-collection program.

4. One error in this experiment is the small inside volume of the white stem that leads to the
inside of the Gas Pressure Sensor. The volume of this space is about 0.8 mL. This means that
when students enter a volume of 10 mL (as read on the syringe), the volume is really about
10.8 mL. To compensate for this error, you could have your students add 0.8 mL to each of
the volumes they enter. They will get somewhat better ratios of pressures in questions 1—4,
using this method.

SAMPLE RESULTS

Volume Pressure Constant, k

(mL) (kPa) (PeV}
5.0 204.6 1023
7.5 136.8 1026

10.0 103.3 1033

12.5 82.1 1026

15.0 69.9 1048

17.5 58.8 1028

20.0 50.7 1013
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Experinent 30
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Pressure vs. Volume

Pressure vs. Reciprocal of Volume

ANSWERS To QUESTIONS

I. The Pressure doubled when the volume wag halved.

2. The Pressure became half as great when the volume wag doubled,
3. Typical results are 63 kpa when the volume 1516 mL ag
1€ pressure corresponding

0 a volume of | ¢
s 8 mI..

d 126 kPa when the volume js 8 mL,.
Pressure whey the volume g

mL is expected 1o be about half as great as the

- Since the Pressure reading at 20.0 mL jg about 50 kPa, the pressure should pe about 25 kpa a¢
» because the Pressure hatves whep the vo] i
mL is about 20y kPa. The Pressure at 2.5 mI, cap be expected to be about 400 kp, because

€ pressure doubleg when the volume is halyed,

3. Answers will vary.
6. Gas pressure and voly

me vary inversely. Expianations will vary. A table of resuits, such as
the one in the Samplie Results table on the Previous page can be used to bring out this
re]ationship.

7. PV=fisan, ation €Xpressing the relationship between 8as pressure and volume, The
Sample Resy, «able helps show this,

{
¢
"
a
&
=
=
=
@
=
&=
e
=

30-27

Plysical Science wiy Vernier




